Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip's Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip's code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, Accuron, dsPIC, KeeLog, KeeLog logo, MPLAB, PIC, PICmicro, PICSTART, PRO MATE, rPIC and SmartShunt are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

FilterLab, Linear Active Thermistor, MXDEV, MXLAB, SEEVAL, SmartSensor and The Embedded Control Solutions Company are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, CodeGuard, dsPICDEM, dsPICDEM.net, dsPICworks, dsSPEAK, ECAN, ECONOMONITOR, FanSense, In-Circuit Serial Programming, ICSP, ICEPIC, Mindi, MiWi, MPASM, MPLAB Certified logo, MPLIB, MPLINK, mTouch, PICkit, PICDEM, PICDEM.net, PICtail, PIC32 logo, PowerCal, PowerInfo, PowerMate, PowerTool, REAL ICE, rFLAB, Select Mode, Total Endurance, UNI/O, WiperLock and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their respective companies.

© 2008, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

 Printed on recycled paper.

Microchip received ISO/TS-16949:2002 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KeeLog® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip's quality system for the design and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT SYSTEM
CERTIFIED BY DNV
ISO/TS 16949:2002

DS51721B-page ii © 2008 Microchip Technology Inc.
Table of Contents

Preface ...................................................................................................................................... 1

Chapter 1. Introduction
  1.1 Introduction ...................................................................................................................... 5
  1.2 Development Kit Contents ............................................................................................. 5
  1.3 PICDEM™ PIC18 Explorer Demonstration Board ............................................................. 6
  1.4 Sample Devices .............................................................................................................. 7
  1.5 Sample Programs ........................................................................................................... 7

Chapter 2. Getting Started
  2.1 Board as Stand-Alone Device .......................................................................................... 9
  2.2 Board with In-Circuit Debugger ..................................................................................... 11
  2.3 Board with PIM Attached Devices .................................................................................. 12
  2.4 Programming the Microcontrollers .................................................................................. 16
  2.5 Connecting to Host PC for RS-232 Communication ....................................................... 19

Chapter 3. PICDEM™ PIC18 Explorer Demonstration Board Tutorial Program
  3.1 Tutorial Program Operation ............................................................................................. 23
  3.2 Source Code and Data Sheets ......................................................................................... 25

Appendix A. Hardware Details
  A.1 Hardware Elements ......................................................................................................... 27
  A.2 Board Layout and Schematics ......................................................................................... 30

Worldwide Sales and Service ................................................................................................. 34
NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the PICDEM™ PIC18 Explorer Demonstration Board. Items discussed in this chapter include:

• Document Layout
• Conventions Used in This Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the PICDEM PIC18 Explorer Demonstration Board as a development tool to emulate and debug firmware on a target board. The manual layout is as follows:

• Chapter 1. “Introduction” – Overview of the development board and kit
• Chapter 2. “Getting Started” – Description of the different ways to use the board
• Chapter 3. “PICDEM™ PIC18 Explorer Demonstration Board Tutorial Program” – Explanation of the tutorial preprogrammed on the sample devices
• Appendix A. “Hardware Details” – Description of the board’s hardware elements, including layout and schematic drawings
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

## DOCUMENTATION CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arial font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td>MPLAB® IDE User’s Guide</td>
</tr>
<tr>
<td>Emphasized text</td>
<td>...is the only compiler...</td>
<td></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td>File&gt;Save</td>
</tr>
<tr>
<td><strong>Bold characters</strong></td>
<td>A dialog button</td>
<td>Click OK</td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the Power tab</td>
</tr>
<tr>
<td></td>
<td>A button on board</td>
<td>Press RB0.</td>
</tr>
<tr>
<td><strong>N'Rnnnn</strong></td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
</tr>
<tr>
<td><strong>Courier New font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td>#define START</td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td>autoexec.bat</td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td>c:\mcc18\h</td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td>0xFF, ‘A’</td>
</tr>
<tr>
<td><strong>Italic Courier New</strong></td>
<td>A variable argument</td>
<td>file.o, where file can be any valid filename</td>
</tr>
<tr>
<td><strong>Square brackets [ ]</strong></td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
</tr>
<tr>
<td>**Curly brackets and pipe character: {</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
</tr>
<tr>
<td><strong>}</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Ellipses...</strong></td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
</tr>
<tr>
<td></td>
<td>Represents code supplied by user</td>
<td>void main (void) { ... }</td>
</tr>
</tbody>
</table>
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Sending in the Warranty Registration Card entitles users to receive new product updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the PICDEM PIC18 Explorer Demonstration Board. Other useful documents are listed below.

• On the board kit’s CD-ROM:
  - Readme file
  - Other reference documents
• Other documents, available at http://microchip.com:
  - “MPLAB® ICD 2 In-Circuit Debugger User’s Guide” (DS51331)
  - “PICkit™ 2 Programmer/Debugger User’s Guide” (DS51553)
  - “Microchip Development Systems Ordering Guide” (DS30177)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at http://microchip.com. This web site is used as a means to make files and information easily available to customers. The web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; and MPLIB™ and MPLAB LIB30 object librarians.

• **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB ICE 2000 and MPLAB ICE 4000.

• **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debugger, MPLAB ICD 2.

• **MPLAB® IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE project manager and general editing and debugging features.

• **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® Plus and PICkit™ 1 development programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY

**Revision A (March 2008)**

• Initial release of this document.

**Revision B (May 2008)**

• Name and title change.
Chapter 1. Introduction

1.1 INTRODUCTION

The PICDEM™ PIC18 Explorer Demonstration Board is the latest demonstration board for evaluating Microchip Technology’s PIC18FXXXX and PIC18FXXJXX families of devices.

The board can be used as a stand-alone device or with an in-circuit debugger, such as the MPLAB® ICD 2, and host PC.

Sample programs are provided to demonstrate the unique features of the supported devices. Free software development tools are available for application development and debugging.

1.2 DEVELOPMENT KIT CONTENTS

The PICDEM PIC18 Explorer Demonstration Board Kit comes with the following:

- PICDEM™ PIC18 Explorer Demonstration Board (Figure 1-1)
- Board-mounted PIC18F8722 and an alternate PIC18F87J11 mounted on a Plug-In Module (PIM)
- CD-ROM that contains:
  - Sample programs, source code and Hex files
  - “PICDEM™ PIC18 Explorer Demonstration Board User’s Guide”
  - Other referenced documents

If you are missing any part of the kit, contact your nearest Microchip sales office listed in the back of this publication.

The MPLAB® Integrated Development Environment (IDE) is a free, integrated software tool set for application development and debugging. Compilers and other board-compatible software and hardware tools can be purchased.

To download the MPLAB IDE software and documentation, or get information on the other tools, visit http://microchip.com.
1.3 PICDEM™ PIC18 EXPLORER DEMONSTRATION BOARD

The PICDEM PIC18 Explorer Demonstration Board has the following hardware features with each feature’s number corresponding to the number in Figure 1-1 that shows the feature’s location on the board:

1. PIC18F8722 microcontroller – The sample, primary microcontroller mounted on the board.
2. Male header pins for connecting Plug-In Modules (PIMs). A PIM enables an alternate PIC18 device to be connected to the board, as the primary microcontroller.
3. In-Circuit Debugger (ICD) connector.
5. 10 kΩ potentiometer for analog inputs.
6. Push button switch – For external Reset.
7. USB connector – For RS-232 communication.
8. PIC18LF2450 microcontroller – For converting RS-232 communication to USB protocol for attachment of a host PC.
9. 12 MHz crystal – For the PIC18LF2450 microcontroller.
10. RS-232 DB9 socket and associated hardware – For direct connection to an RS-232 interface.
11. Jumper J13 for routing RS-232 communication through either the USB port or the RS-232 socket.
12. Jumper J4 – For selecting between programming the main PIC® device or the PIC18LF2450, used for USB to RS-232 communication.
13. Switch S4 – For designating the main microcontroller as either the board-mounted PIC18F8722 or a PIM-mounted microcontroller.
14. LED – For power-on indication.
15. JP1 – For disconnecting the eight display LEDs.
16. Eight LEDs.
17. 32.768 kHz crystal – For Timer1 clock operation.
18. Two push button switches – For external stimulus.
19. Analog temperature sensor, MPC9701A.
20. 25LC256 SPI EEPROM.
21. JP2 – To enable/disable EEPROM.
22. JP3 – To enable/disable LCD.
23. 10 MHz crystal – For the main microcontroller.
24. PICtail™ daughter board connector socket.
25. SPI I/O expander – For LCD display, MCP23S17.
26. Prototype area – For user hardware.
27. LCD display.
28. J2 three-pin, male header – For selecting between a voltage of 3.3V or 5V.
29. J14 four-pin, male header – For use with a PIM, if required, to connect 3.3V or 5V, Vin and ICE MCLR.
1.4 SAMPLE DEVICES

The PICDEM PIC18 Explorer Demonstration Board comes with two sample devices that alternately can be used as the main microcontroller:
- An 18-pin, 5V PIC microcontroller (the PIC18F8722) mounted on the board
- A 3.3V PIC18 device (PIC18F87J11) mounted on an 80-pin PIM that connects to the demo board via an 80-pin male

1.5 SAMPLE PROGRAMS

The PICDEM PIC18 Explorer Demonstration Board Kit includes a CD-ROM with sample demonstration programs. These programs may be used with the included sample devices and with an In-Circuit Debugger (ICD).
Also provided on the disc is demonstration source code that includes several assembly source code (ASM) files and one Hex compiled code file.
Chapter 2. Getting Started

The PICDEM™ PIC18 Explorer Demonstration Board may be used in a variety of ways. Table 2-1 lists the three primary configurations and the required equipment and capabilities of each.

TABLE 2-1: PICDEM™ PIC18 EXPLORER DEMONSTRATION BOARD CONFIGURATIONS

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Board Connections</th>
<th>Board Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stand-alone board</td>
<td>Power supply</td>
<td>• Access board’s full functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Demonstrate sample code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Display functionality with LCD or LEDs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connect ICD/programmer for debugging or programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connect PICtail™ daughter cards</td>
</tr>
<tr>
<td>Board with in-circuit debugger/programmer</td>
<td>• Power supply</td>
<td>• Access board’s full functionality</td>
</tr>
<tr>
<td></td>
<td>• In-Circuit Debugger (ICD) that also can be used as a programmer</td>
<td>• Demonstrate sample code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Develop and debug code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reprogram microcontrollers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connect PICtail daughter cards</td>
</tr>
<tr>
<td>Board with alternate microcontroller, attached through a Plug-In Module (PIM)</td>
<td>• Power supply</td>
<td>• Substitute PIM-mounted device as main microcontroller†</td>
</tr>
<tr>
<td></td>
<td>• ICD that also can be used as a programmer</td>
<td>• Use 3.3V or 5V devices as main microcontroller</td>
</tr>
<tr>
<td></td>
<td>• PIM with mounted microcontroller</td>
<td>• Demonstrate sample code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Develop and debug code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reprogram microcontrollers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connect PICtail daughter cards</td>
</tr>
</tbody>
</table>

† PIM enables 80, 64, 44 and 28-pin devices to be used as the main microcontroller. For information on the available PIMs, go to http://microchip.com.

This chapter describes:
- How to implement each of the uses described in Table 2-1
- How to reprogram the main and RS-232 to USB microcontrollers
- How to connect the demonstration board to a host PC for RS-232 communication

2.1 BOARD AS STAND-ALONE DEVICE

In using the PICDEM PIC18 Explorer Demonstration Board as a stand-alone device, an implementation can:
- Use the board as is, utilizing the firmware loaded on the main, PIC18F8722 microcontroller and RS-232 to USB PIC18LF2450 microcontroller
- Reprogram the main, PIC18F8722 microcontroller or the RS-232 to USB, PIC18LF2450 microcontroller and demonstrate user programs
2.1.1 Using the Board As Is

To immediately implement the PICDEM PIC18 Explorer Demonstration Board to demonstrate the PIC18F8722 microcontroller:

1. Designate the mounted, PIC18F8722 device as the board’s main microcontroller by moving Switch S4 to PIC MCU, as shown in Figure 2-1.

   FIGURE 2-1: S4 SWITCH – SETTING FOR DEFAULT MAIN MICROCONTROLLER

<table>
<thead>
<tr>
<th>Switch Location</th>
<th>Switch Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>S4 Switch</td>
<td>PIC® MCU</td>
</tr>
<tr>
<td></td>
<td>S4</td>
</tr>
<tr>
<td></td>
<td>ICE</td>
</tr>
</tbody>
</table>

2. Enable the LEDs by placing a jumper on JP1, as shown in Figure 2-2.

   FIGURE 2-2: JP1, JP2 AND JP3 JUMPERS

<table>
<thead>
<tr>
<th>JP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP3</td>
</tr>
<tr>
<td>JP1</td>
</tr>
</tbody>
</table>

3. Enable the EEPROM and the LCD by placing a jumper on JP2 and JP3, as shown in Figure 2-2.

4. Apply power to the board.

   For information on acceptable power sources, see Appendix A. “Hardware Details”.

The device now can be demonstrated using the tutorial program. (See Section 3.1 “Tutorial Program Operation”.)
2.1.2 Reprogramming the Microcontroller

Either or both the main PIC18F8722 microcontroller and RS-232-USB, or the PIC18LF2450 microcontroller, can be reprogrammed for running the board as a stand-alone device.

To implement this usage:
1. Reprogram either or both devices, as described in Section 2.4 “Programming the Microcontrollers”.
2. Disconnect the programming devices.
3. Follow the procedure given in Section 2.1.1 “Using the Board As Is”.

2.2 BOARD WITH IN-CIRCUIT DEBUGGER

The PICDEM PIC18 Explorer Demonstration Board can also be connected to an In-Circuit Debugger (ICD) that is connected to a host PC. This can be done with the board’s main microcontroller configured as either the mounted PIC18F8722 device or an alternate device mounted to a PIM that is plugged into the board. (For information on PIM attached devices, see Section 2.3 “Board with PIM Attached Devices”.)

The MPLAB® ICD 2 In-Circuit Debugger is an inexpensive ICD that could be used. (For more information, see Section 2.4.1 “Programming Requirements”.) The ICD is connected, as shown in Figure 2-3, to the ICD connector. For operational information, see “MPLAB® ICD 2 In-Circuit Debugger User’s Guide” (DS1331).

The PICDEM™ PIC18 Explorer Demonstration Board can alternately use the MPLAB® REAL ICE™ Emulator as a debugger. For more information, see the “Microchip Development Systems Ordering Guide” (DS30177).

FIGURE 2-3: BOARD WITH MPLAB® ICD 2 IN-CIRCUIT DEBUGGER ATTACHED

For information on other microcontroller compatible ICD or ICE devices, see the “Microchip Development Systems Ordering Guide” or the Microchip web site at http://microchip.com.
2.3 BOARD WITH PIM ATTACHED DEVICES

The PICDEM PIC18 Explorer Demonstration Board also can be used to demonstrate other PIC18 devices – having them replace the PIC18F8722 mounted on the board as the board’s main microcontroller. This is done by attaching a Plug-In Module (PIM) that has the other microcontroller mounted to it.

The PICDEM PIC18 Explorer Demonstration Board comes with the PIC18F87J11 PIM representing the super set device for the PIC18 J-series of products.

FIGURE 2-4: PICDEM™ PIC18 EXPLORER DEMONSTRATION BOARD WITH PIM

The PIM enables the attachment of 80, 64, 44 or 28-pin devices. Some PIMs also enable the board’s 5V output to be automatically reset to 3.3V.

For a list of microcontroller-compatible PIMs, see the ‘Microchip Development Systems Ordering Guide’ (DS30177) or go to http://microchip.com.
2.3.1 Attaching the PIM

To attach the PIM:

1. Seat the PIM in the 80-pin, elevated, male connectors that encircle the PIC18F8722 (see Figure 2-5).

FIGURE 2-5: PIM CONNECTORS AND S4 SWITCH

Alternately, an In-Circuit Emulator (ICE) can be attached to the male connectors. This enables in-circuit emulation and user development and debugging of code. For information on this use, see the Microchip web site (http://microchip.com).

2. To designate the PIM-mounted device as the main microcontroller, set Switch S4 (shown in Figure 2-5) to ICE (see Figure 2-6).

FIGURE 2-6: S4 SWITCH – SETTING FOR PIM-MOUNTED DEVICES

3. If you are converting from the board’s default Vdd of 5V, see “Varying the Device Voltage (5V/3.3V)” on page 14.
2.3.2 Varying the Device Voltage (5V/3.3V)

By default, the PICDEM PIC18 Explorer Demonstration Board’s V\text{DD} supply is 5V. The V\text{DD} can be varied, for PIM-mounted microcontrollers, from 5 to 3.3V to accommodate devices running at 5 or 3.3V. This V\text{DD} is named VAR.

The PICDEM PIC18 Explorer Demonstration Board enables the voltage change with PIM connection headers and a variable voltage regulator. PIMs mounted with 3.3V devices implement the voltage change through two resistors with values that produce the desired voltage. (See “Calculating Other V\text{DD} Values” on page 15.)

The voltage varying hardware includes:

- An adjustable voltage regulator, the LM317 – Located on the board, left of the PIM connectors and marked as U2 (recognizable by the TO-220 package commonly used for transistors)
- Header J2 – Located above the PIM connectors
- Resistors R25 and R26 – Located below jumper J13
- Resistors R101 and R102 – Located on the PIM board

In setting the board’s voltage:

- For the default, 5V voltage –
  - For board-mounted PIC18F8722 device:
    - Board resistor R25 = 1 k\Omega
    - Board resistor R26 = 330\Omega
  - For a PIM-mounted, 5V microcontroller:
    - Board resistors R25 and R26 – Same values of 1 k\Omega and 330\Omega, respectively
    - PIM-mounted resistors R101 and R102 – Unpopulated
- For 3.3V V\text{DD} (achieved only with a PIM with a mounted 3.3V device, such as the PIC18F87J11) –
  - Header J2 goes into the PIM board where resistors R101 and R102 are inserted in parallel to the board resistors R25 and R26
  - PIM board resistor R101 can be unpopulated
  - PIM board resistor R102 can be 1.18 k\Omega.

Note: For precise adjustment of V\text{DD}, 1% resistors are recommended.
2.3.3 Calculating Other VDD Values

Other VDD values can be produced by the LM317 adjustable voltage regulator by populating the PIM board’s R101 and R102 with different value resistors. A brief overview follows, on how to calculate alternate values for these resistors. For detailed information, see the LM317 data sheet.

**EQUATION 2-1: REGULATOR VOLTAGE OUTPUT**

\[
V_{OUT} = V_{REF}\left(1 + \frac{R2}{R1}\right) + I_{ADJ} \cdot R2
\]

\(I_{ADJ}\) is minimized by the LM317, so it can be assumed to be zero, or very small. \(V_{REF}\) is the reference voltage developed by the LM317 between the output and adjustment terminal and equals 1.25V. That produces the equations shown in Equation 2-2.

**EQUATION 2-2: CALCULATING OUTPUT VOLTAGE**

\[
V_{OUT} = 1.25V\left(1 + \frac{R2}{R1}\right)
\]

\[
R2 = R25 \parallel R102 = \frac{(R25 \cdot R102)}{(R25 + R102)}
\]

\[
R1 = R26 \parallel R101 = \frac{(R26 \cdot R101)}{(R26 + R101)}
\]

As stated previously, \(R25 = 1\, \text{k}\Omega\) and \(R26 = 330\, \Omega\). Without R102 and R101 being inserted in parallel on the PIM board, \(V_{OUT} = 1.25V(1 + 1\, \text{k}\Omega/330\, \Omega) = 5.04V\). To calculate a desired \(V_{OUT}\):

1. Solve for \(R2\), given \(R1 = R26 = 330\, \Omega\).
2. Now knowing \(R2\) and \(R25\), solve for \(R102\).
3. Determine the nearest available resistor value for \(R102\) and recalculate the resulting VDD to make sure it does not exceed the maximum VDD for the part you will be using.

Table 2-2 shows the R101 and R102 resistor values to use for different VDD values. The table assumes that the PICDEM PIC18 Explorer Demonstration Board’s R25 and R26 resistors are left at their default values of 1KΩ and 330Ω, respectively.

<table>
<thead>
<tr>
<th>VDD</th>
<th>R101 Value</th>
<th>R102 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>5V</td>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>3.6V</td>
<td>Open</td>
<td>1.62 kΩ</td>
</tr>
<tr>
<td>3.3V</td>
<td>Open</td>
<td>1.18 kΩ</td>
</tr>
<tr>
<td>3.0V</td>
<td>Open</td>
<td>866 RΩ</td>
</tr>
</tbody>
</table>

† This table assumes that the PICDEM PIC18 Explorer Demonstration Board’s R25 and R26 resistors are left at their default values of 1 kΩ and 330Ω, respectively.
2.4 PROGRAMMING THE MICROCONTROLLERS

Either or both the main microcontroller (PIC18F8722) and the RS-232 to USB, or the PIC18LF2450 microcontroller, can be reprogrammed. The main microcontroller that is reprogrammed can either be the board-mounted PIC18F8722 device or an alternate main microcontroller, mounted on a PIM attached to the board.

This section discusses:
• Programming Requirements
• Loading the Program

2.4.1 Programming Requirements

To reprogram a sample device, the following is required:
• Program source code – Sample code is preloaded on the device, but user source code can be substituted. If this is done, the sample program can be restored using the file on the board kit’s CD-ROM.
• An assembler or compiler – Source code must be assembled or compiled into a Hex file before it can be programmed into the device.
• A programmer – Once the code is in the Hex file format, this device programs the microcontroller’s Flash memory.
  If the code protection bit(s) have not been programmed, the on-chip program memory can be read out for verification purposes.

In meeting these requirements:
• Code development and debugging –
  The free MPLAB® IDE software development tool includes a debugger and several other software tools as well as a unified graphical user interface for working with other Microchip and third-party software and hardware tools.
• Assembler –
  The free MPLAB IDE tool includes the MPASM™ assembler.
• Compiler –
  Microchip’s MPLAB® C18 is a C compiler for PIC18 microcontrollers and is fully integrated for the MPLAB IDE environment.
• Programmer –
  Microchip’s MPLAB® In-Circuit Debugger (ICD) 2 or PICkit™ Starter Kit can be used to program the device and both are fully integrated for the MPLAB IDE environment.

The free MPLAB IDE tool set and its documentation can be downloaded at http://microchip.com.

For a list of the other mentioned devices’ documentation, see “Recommended Reading” on page 3.

Other assemblers/compilers can be used. For a list of tools compatible with PIC microcontrollers, see the Microchip web site (http://microchip.com).
2.4.2 Loading the Program

This section describes how to program the PICDEM PIC18 Explorer Demonstration Board using the MPLAB® Integrated Development Environment (IDE) and the sample Hex code on the compact disc in the PICDEM PIC18 Explorer Demonstration Board’s Kit.

2.4.2.1 REPROGRAMMING WITH THE COMPACT DISC SAMPLE CODE

To program the PIC18F8722:

1. Launch the MPLAB IDE application and select Configure>Select Device>18F8722.
2. To start the programmer, select Programmer>Select Programmer>ICD2.
3. To open the Hex code file, select File>Import>Open and select CD/Hex/18F8722/Demo8722.hex.
4. Connect the J4 jumper to Main (main controller), as shown in Figure 2-7.

conom

To program the PIC18F87J11 on the PIM:

1. Attach the PIM to the demonstration board.
2. Move the S4 switch to ICE.

Note: Both steps 1 and 2 are described in “Attaching the PIM” on page 13.

3. Launch the MPLAB IDE application and select Configure>Select Device>18F87J11.
4. To start the programmer, select Programmer>Select Programmer>ICD2.
5. To open the Hex code file, select File>Import>Open and select CD/Hex/18F87J11/Demo87J11.hex.
6. Connect the J4 jumper to Main (main controller), as shown in Figure 2-7.
To program the PIC18LF2450 for RS-232 UART communication:

1. Launch the MPLAB IDE application and select Configure>Select Device>18F2450.
2. To start the programmer, select Programmer>Select Programmer>ICD2.
3. To open the Hex code file, select File>Import>Open and select CD/Hex/RS232_USB_18F2450/Demo2450.hex.
4. Connect the J4 jumper to USB, as shown in Figure 2-8.

TABLE 2-8: J4 JUMPER AND ‘USB’ SETTING

<table>
<thead>
<tr>
<th>Jumper Location</th>
<th>Jumper Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>J4 Jumper</td>
<td></td>
</tr>
</tbody>
</table>

FIGURE 2-8: J4 JUMPER AND ‘USB’ SETTING
2.5 CONNECTING TO HOST PC FOR RS-232 COMMUNICATION

As shown in Figure 2-9, there are two ways to connect a PC to the PICDEM PIC18 Explorer Demonstration Board.

- Via the USB Port
- Via the DB9 Pin (RS-232 Port)

FIGURE 2-9: BOARD TO PC CONNECTION

2.5.1 PC Connection Via DB9 Pin

To connect the PICDEM PIC18 Explorer Demonstration Board to a host PC via the nine-pin DB9 connector, set jumper J13, as shown in the first illustration in Figure 2-10. This routes the main microcontroller’s communications through a transceiver.

FIGURE 2-10: JUMPER J13 – SETTINGS FOR RS-232 OR USB
2.5.2 PC Connection Via USB Port

If the board PC communication is via the USB port, the data will be routed through the PIC18LF2450 mounted on the board, to convert the RS-232 communication to the USB protocol.

To connect the PICDEM PIC18 Explorer Demonstration Board to a host PC via the USB port:
1. Set jumper J13, as shown in the second illustration in Figure 2-10.
2. Install the required file on the host PC. (See the following procedure.)

If the USB port is used, an *.inf file must be installed on the host PC. To do this:
1. Create a folder named, HPCINF, anywhere on the host PC's hard drive.
2. Using the development kit's CD, copy the file, mchpcdc.inf, into that folder.
3. Connect the board to the PC and power up the board. The pop-up window, shown in Figure 2-11, appears.

**Note:** This procedure displays the dialog boxes that appear for the Windows® XP operating system.

**FIGURE 2-11: INSTALLING USB *.inf FILE ON PC – SCREEN 1**

4. Select the Install from a list or specific location option and click Next. The screen shown in Figure 2-12 appears.
5. Select the check box, **Include this location in the search**, enter the name of the path (created in Step 1) in the text box below and click **Next**. The screen shown in Figure 2-13 appears.

6. Press **Finish**. The RS-232 to USB functionality is ready to be used.
Chapter 3. PICDEM™ PIC18 Explorer Demonstration Board Tutorial Program

The tutorial program is preprogrammed into the PIC18F8722 on the PICDEM PIC18 Explorer Demonstration Board. This program is also on the PICDEM PIC18 Explorer Demonstration Board kit's CD-ROM so that it can be reprogrammed on the sample device if it the device had been preprogrammed.

For detailed information on the PICDEM PIC18 Explorer Demonstration Board hardware, see Appendix A. “Hardware Details”.

3.1 TUTORIAL PROGRAM OPERATION

The tutorial program consists of three components that appear sequentially on the board’s LCD. A flowchart, showing the button navigation through the entire program, is given in Figure 3-2.

When the board boots up, the device name appears on the LCD and the program proceeds to the first component.

To select menu options, use the RB0 and RA5 buttons on the bottom of the board (see Figure 3-1).

**FIGURE 3-1: RB0 AND RA5 BUTTONS**

1. **Voltmeter**

   This mode uses the Analog-to-Digital Converter (A/D) module to measure the voltage of the R3 potentiometer and display a value between 0.00V and 5.00V on the LCD. (In the case of 3.3V devices, the displayed value will be 0.00V to 3.3V.)

   The voltage reading is updated continually until the mode is exited by pressing RB0.

2. **Temperature**

   This mode uses an MCP9701A thermal sensor to measure ambient temperature in Celsius and displays it on the LCD. The program also stores the current temperature, when exited, by writing to a defined address on the external, on-board EEPROM.

   Communication between the microcontroller and sensor is done by the A/D module. To exit this mode, press RB0.
3. Clock

Once this mode is entered from the main menu, a Real-Time Clock (RTC) will start counting from 00:00:00. The Timer1 module uses a 32-kHz clock crystal to establish the clock.

The program also sends the time data to the RS-232 serial port using the Universal Asynchronous Receiver Transmitter (UART) on the microcontroller. This enables the host PC to display the LCD’s data using the Hyper Terminal application on the PC.

Note: For information on connecting the board’s RS-232 serial port to the PC, see Section 2.5 “Connecting to Host PC for RS-232 Communication”.

If using the Hyper Terminal application, use the settings given in Table 3-1.

**TABLE 3-1: HYPER TERMINAL SETTINGS**

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bits per second</td>
<td>9600</td>
</tr>
<tr>
<td>Data bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop bits</td>
<td>1</td>
</tr>
<tr>
<td>Flow control</td>
<td>None</td>
</tr>
</tbody>
</table>

To set the clock time:

1. Enter the clock-setting program by pressing RB0. The clock begins running.
2. To set the hours value, press RA5.
3. Increment the hours to the desired value by pressing RB0.
4. To set the minutes value, press RA5.
5. Increment the minutes to the desired value by pressing RB0.
6. To start the clock with the set time, press RA5. The LCD returns to an active clock display.
7. To return to the main menu, press RB0.
3.2 SOURCE CODE AND DATA SHEETS

The PICDEM PIC18 Explorer Demonstration Board Kit’s CD-ROM contains the assembled tutorial program (the Hex files) as well as the source code used to create those Hex files. The CD has device-specific directories for each set of source code and Hex files.

For information on reprogramming the device with new or modified code, see Section 2.1 “Board as Stand-Alone Device”.

FIGURE 3-2: TUTORIAL PROGRAM FLOWCHART

```
Power-up

PICDEM™ PIC18 Explorer

Voltmeter
RA5 = Next
RB0 = Now

Voltage
RA5 = Next
RB0 = Now

Temperature
RA5 = Next
RB0 = Now

Temperature - 022°C
RB0 = Exit

Clock
RA5 = Next
RB0 = Now

Volt = n.nnV
RB0 = Exit

00.00.02
RA5 = Set, RB0 = Menu

00.00.03
RA5 = ->, RB0 = ++
```
Appendix A. Hardware Details

A.1 HARDWARE ELEMENTS

A.1.1 Processor Sockets

The PICDEM PIC18 Explorer Demonstration Board can be populated with 64 and 80-pin devices. Using a Plug-In Module (PIM), the board also can support 28, 44, 64 and 80-pin devices.

For a list of available PIMs, go to the Microchip web site at http://microchip.com.

A.1.2 Display

Eight LEDs are connected to PORTD of the PICDEM PIC18 Explorer Demonstration Board. The PORTD pins are set high to light the LEDs.

These LEDs may be disconnected by removing jumper JP1.

One LED (D9) lights to indicate when the board has power.

A.1.3 Power Supply

The PIC18 Explorer Board does not come with a power supply. It can be powered, via J1, with an unregulated DC supply of 9V to 15V. The preferred supply is 9V.

For default functionality, a power supply with a current capability of 250 mA is sufficient. Since the board can serve as a modular development platform connecting to multiple expansion boards, voltage regulators (Q1 and Q2) are used. Their maximum current capability is 800 mA. This current capacity may require a power supply of up to 1.6A. Because the regulators do not have heat sinks, long-term operation at such loads is not recommended.

When the board is powered, LED D9 is on, indicating the presence of V_VAR. If an external supply is needed, Microchip’s 9V, 750 mA power supply (part number AC162039) can be used.

Note: Do not attempt to power the PICDEM PIC18 Explorer Demonstration Board using the MPLAB ICD 2 module. That module is not designed to be a USB bus power source.

A.1.4 RS-232 Serial Port

An RS-232, level-shifting integrated circuit has been provided with all the necessary hardware to support the connection of an RS-232 host through the DB9 connector. The port can be connected to a PC using a straight-through cable.

The PIC18 receive and transmit pins are tied to the receive and transmit lines of the MAX3232 transceiver through jumper J13. That jumper can direct where the receive and transmit pins of the PIC18 are connected, either to:

• The PIC18LF2450 which does the RS-232 to USB communication
• The MAX3232 transceiver

Note: For details on this connection, see Section 2.5 “Connecting to Host PC for RS-232 Communication”.
A.1.5  Switches
The following switches are available:
• S1 – Active-low switch connected to RB0
• S2 – Active-low switch connected to RA5
• S3 – MCLR to hard reset the processor
• S4 – MCLR select switch.

If the on board, PIC18F8722 microcontroller is being used, set this to PIC MCU.
If an alternate, PIM-mounted microcontroller is being used, set this to ICE.

A.1.6  Oscillator Options
The main oscillator uses a 10 MHz crystal (Y1) which serves as the controller’s primary oscillator. A second circuit, using a 32.768-kHz (watch type) crystal (Y2), functions as the Timer1 oscillator, the source for the Real-Time Clock/Calendar (RTCC) and secondary oscillator.
The PIC18LF2450, the heart of the RS-232 to USB conversion, is independently clocked with its own 12 MHz crystal (Y3).

A.1.7  Analog Input (Potentiometer)
A 10 kΩ potentiometer is connected through a series resistor to AN0. To provide an analog input to one of the controller’s Analog-to-Digital (A/D) channels, the potentiometer can be adjusted from VDD to GND.

A.1.8  ICD Connector
Microchip’s low-cost, in-circuit debugger, MPLAB ICD 2, can be connected to the modular connector (J10). The ICD connector utilizes RB6 and RB7 for in-circuit debugging.

Note: For details, see Section 2.4.1 “Programming Requirements”.

A.1.9  PICkit™ 2 Connector
Microchip’s low-cost programmer, PICkit 2, can be connected to the 6-pin interface provided by J12.

Note: For details, see Section 2.4.1 “Programming Requirements”.

A.1.10 Temperature Sensor
The analog thermal sensor, MCP9701A (U1), is used for monitoring temperature. The device is connected to the Analog-to-Digital Converter (A/D) module through RA1.

A.1.11  Serial EEPROM
A 25LC256, 256 Kbit (32K x 8) serial EEPROM (U9) is included for nonvolatile storage of firmware.
The EEPROM also can demonstrate the operation of the Serial Peripheral Interface (SPI) bus. The EEPROM is enabled or disabled from the SPI bus by jumper JP2.

A.1.12 PICtail™ Daughter Board Connector
The PICtail™ interface enables the PICDEM PIC18 Explorer Demonstration Board to be connected directly to available PICtail daughter board cards. This provides a one-to-one connection between the microcontrollers and the cards through SPI/I²C™ interfaces.
A.1.13 LCD

An LCD display with two lines, 16 characters each, is connected to the SPI I/O expander, MCP23S17. The two control lines and eight data lines are connected to the I/O expander.

The I/O expander has an SPI interface that connects it to the microcontroller. The I/O expander is disabled or enabled from the SPI by jumper JP3.

A.1.14 Sample Devices

A sample part programmed with a simple program is included in the PICDEM PIC18 Explorer Demonstration Board Kit. The devices’ I/O features and port connections are listed in Table A-1.

<table>
<thead>
<tr>
<th>Device</th>
<th>LEDs</th>
<th>RS-232/USB</th>
<th>S1</th>
<th>S2</th>
<th>S3</th>
<th>LCD</th>
<th>Pot R3</th>
<th>EEPROM</th>
<th>Temp Sensor</th>
<th>ICD/ PICkit™ 2</th>
<th>Y1, Y2</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIC18F8722</td>
<td>RD7:RD0</td>
<td>RC6/RC7</td>
<td>RB0</td>
<td>RA5</td>
<td>RA0</td>
<td>RC3:RC5</td>
<td>RA0</td>
<td>RC3:RC5</td>
<td>RA1</td>
<td>RB6/RB7</td>
<td>Yes</td>
</tr>
<tr>
<td>PIC18F87J11</td>
<td>RD7:RD0</td>
<td>RC6/RC7</td>
<td>RB0</td>
<td>RA5</td>
<td>RA0</td>
<td>RC3:RC5</td>
<td>RA0</td>
<td>RC3:RC5</td>
<td>RA1</td>
<td>RB6/RB7</td>
<td>Yes</td>
</tr>
</tbody>
</table>
A.2 BOARD LAYOUT AND SCHEMATICS

FIGURE A-1: PICDEM™ PIC18 EXPLORER DEMONSTRATION BOARD LAYOUT